
Ridgeline Release Notes
Software Version 4.0 Service Pack 2

121099-00 Rev 01
Published February 2015

121099-00 Rev 01



Copyright © 2015 Extreme Networks, Inc. All Rights Reserved.

Legal Notices
Extreme Networks, Inc., on behalf of or through its wholly-owned subsidiary, 
Enterasys Networks, Inc., reserves the right to make changes in specifications 
and other information contained in this document and its website without 
prior notice. The reader should in all cases consult representatives of Extreme 
Networks to determine whether any such changes have been made.

The hardware, firmware, software or any specifications described or referred 
to in this document are subject to change without notice.

Trademarks
Extreme Networks and the Extreme Networks logo are trademarks or 
registered trademarks of Extreme Networks, Inc. in the United States and/or 
other countries. 

All other names (including any product names) mentioned in this document 
are the property of their respective owners and may be trademarks or 
registered trademarks of their respective companies/owners.

For additional information about Extreme Networks trademarks, go to: 
www.extremenetworks.com/company/legal/trademarks/

Support
For product support, including documentation, visit: 
www.extremenetworks.com/support/ 

Contact
Extreme Networks, Inc. 
145 Rio Robles
San Jose, CA 95134
Tel: +1 408-579-2800
Toll-free: +1 888-257-3000



Table of Contents
Overview.....................................................................................................................5

What’s New in Ridgeline 4.0 Service Pack 2 ......................................................................... 6
Ridgeline Device Inventory Limit ......................................................................................... 6
Map Removed from Main View ............................................................................................. 6
“Select All” Option for Main and Group View Tables Removed ........................... 6
Support for Summit X480 Series Switches Dual Software Images ................... 6

Important Limitations and Caveats for Ridgeline ................................................................7
Joint Interoperability Test Command (JITC) in ExtremeXOS 15.4 Incompatible 
with Ridgeline .................................................................................................................................7
Ridgeline Server and Client Requirements ......................................................................7
The Ridgeline TFTP Server ......................................................................................................7
Telnet Polling and Ridgeline ....................................................................................................7
Allowing Clients Access to the Server from Behind a Firewall ............................ 8
Switch Access Requirements ................................................................................................ 8

Ridgeline Device Support ............................................................................................................... 9
New Hardware Devices Supported in Ridgeline 4.0 SP2 ........................................ 9
All Devices Supported in Ridgeline ...................................................................................10
Extreme Networks Virtualization (XNV) Device Support ......................................14

Supported VMMs and VMs .............................................................................................14
Other Third-Party Device Support ..................................................................................... 15
SSH Support .................................................................................................................................. 16

Ridgeline Software Licensing ...................................................................................................... 16
License Types ............................................................................................................................... 16
License Calculation .................................................................................................................... 17

Ridgeline Software Documentation ......................................................................................... 18

Limits......................................................................................................................... 19

Open Issues, Known Behaviors, and Resolved Issues .......................................23

Issues Resolved in Ridgeline 4.0 Service Pack 2 ...............................................................24
Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 3 ............................................. 30
Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 2 ............................................... 31
Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 1 ...............................................33
Issues Resolved in Ridgeline 4.0 Service Pack 1 ................................................................36
Clarifications and Known Problems in Ridgeline 4.0 Service Pack 2 ......................37
Troubleshooting .................................................................................................................................41

The Package Debug Info Tool ..............................................................................................41
Client Information from the About Ridgeline Window ............................................41
Collecting Information from Managed Devices ...........................................................41
Improper Installing/Un-installing ...................................................................................... 44

Windows ................................................................................................................................ 44
Linux ......................................................................................................................................... 44

Unable to Log on to Ridgeline with Ridgeline Enabled as RADIUS Client ....45
Solution ....................................................................................................................................46
 3



Table of Contents
Ridgeline 4.0 SP2 Release Notes  4



1

Ridgeline 4.0
Overview
This release note contains a summary of the important information and new features for 
the Ridgeline™ Management Suite 4.0 Service Pack 2. For information about previous 
releases, see the release notes for that release.

Ridgeline 4.0 SP2 increases the number of devices that can be managed in inventory, adds 
hardware device support, and includes bug fixes:

• See Ridgeline Device Inventory Limit on page 6

• See New Hardware Devices Supported in Ridgeline 4.0 SP2 on page 9

• See Issues Resolved in Ridgeline 4.0 Service Pack 2 on page 24

For detailed descriptions of the features in Ridgeline, see the Ridgeline Reference Guide. If 
you need additional help, contact customer support at 800-998-2408 or 
support@extremenetworks.com.

This chapter covers the following topics:

• What’s New in Ridgeline 4.0 Service Pack 2 on page 6

• Important Limitations and Caveats for Ridgeline on page 7

• Ridgeline Device Support on page 9

• Ridgeline Software Licensing on page 16

• Ridgeline Software Documentation on page 18

NOTE

Ridgeline does not provide multi-language support. 
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Overview
What’s New in Ridgeline 4.0 Service Pack 2

Ridgeline Device Inventory Limit
Ridgeline 4.0 SP2 can manage a maximum of 2,000 devices in inventory—an increase over 
the 800 permitted in Ridgeline 4.0 SP1—when using the 64-bit version of Ridgeline 4.0 SP2, 
and 500 devices, when using the 32-bit version of Ridgeline 4.0 SP2.

For other Ridgeline limitations, see Chapter 2, “Limits”on page 19.

Map Removed from Main View
Map view is not available for the Main View group. To see maps for devices, create device 
groups (see the Ridgeline Reference Guide).

“Select All” Option for Main and Group View Tables Removed
You can no longer use the top left check box in the Main View and group views to select all 
items in the devices tables. Use SHIFT + click to select ranges of devices instead.

Support for Summit X480 Series Switches Dual Software Images
For Summit X480 series switches, starting with ExtremeXOS 15.6, two separate software 
image files (main and diagnostic images) are used for both individual switches and stacks 
that include Summit X480 series switches. Ridgeline 4.0 Service Pack 2 now supports 
upgrading using these two images. 

For additional information about Summit X480 software images, see the ExtremeXOS User 
Guide and Release Notes.

For additional information about how to upgrade Summit X480 series switches using 
Ridgeline, see the Firmware Manager chapter in the Ridgeline Reference Guide.
Ridgeline 4.0 SP2 Release Notes  6
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Important Limitations and Caveats for Ridgeline

The following section describe important limitations and caveats about how Ridgeline 
should be used within your network.

Joint Interoperability Test Command (JITC) in ExtremeXOS 15.4 
Incompatible with Ridgeline

Joint Interoperability Test Command (JITC) compliance in ExtremeXOS 15.4 is incompatible 
with Ridgeline operation. 

The command configure snmp compatibility get-bulk replytoo-big-action 
[standard | too-big-error] switches ExtremeXOS from Ridgeline-compatible mode 
(too-big-error), the default mode, to JITC-compliant mode. Switching to JITC-compliant 
mode causes Ridgeline to fail to update its database with device information.

Ridgeline Server and Client Requirements
For minimum requirements for installing the Ridgeline server and client, see the Ridgeline 
Installation and Upgrade Guide.

The Ridgeline TFTP Server
Ridgeline’s built-in TFTP server is intended only for uploading and downloading switch 
configuration files and software image files under Ridgeline’s control. It is not intended for 
use as a general purpose TFTP server. 

Telnet Polling and Ridgeline
Although Ridgeline primarily uses SNMP to retrieve switch status and configuration 
information, it uses Telnet polling to collect certain types of information that are not 
available using SNMP. This includes information about netlogins, device FDB data (if FDB 
polling is enabled) and other selected status. Ridgeline’s use of Telnet polling can affect 
your switches in several ways:

• Each time Ridgeline logs in and out of the switch, entries are created in the switch log. 

• In some cases Ridgeline needs to disable CLI paging to parse the results of certain 
commands. This creates an entry in the switch log file for every occurrence. 

• Over time, these entries can fill the switch log file, and can make it more difficult to 
recognize log entries due to errors or other significant conditions. If these entries in the 
log file become problematic, you can periodically clear the switch log, disable 
Ridgeline’s Telnet polling, reduce Ridgeline’s polling frequency, or use the ExtremeWare 
or ExtremeXOS Event Management System log filtering capability to suppress the log 
entries generated by Ridgeline logon and logoff events. 
Ridgeline 4.0 SP2 Release Notes 7
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Allowing Clients Access to the Server from Behind a Firewall
If the Ridgeline server is located behind a firewall, you must allow Ridgeline clients access 
through the firewall.

To allow clients to access a Ridgeline server that is behind a firewall:
1 Start the Ridgeline client from the same machine where the server is installed.
2 In the navigation pane, click Ridgeline Users And Servers.
3 Click Open Server Properties tab.
4 Select Other from the list.
5 In the Client Port field, enter an available port number in the Property Value column. 

(The default of 0 means any available port.)
6 Click Apply to apply the setting. You are prompted to restart the Ridgeline server to 

implement the changes.
7 Stop, and then restart the Ridgeline server. For instructions, see the Ridgeline Installation 

and Upgrade Guide.
8 In the settings for your firewall, allow exceptions for the following ports:

• The HTTP port used for communication with Ridgeline clients (default is 8080)
• JBoss remoting port: 10555
• The client port you specified in step 5 earlier.

9 Click Apply. Restart the browser to implement these changes. 

Switch Access Requirements
Ridgeline uses SNMP, HTTP/HTTPs, and Telnet to discover and communicate with the 
devices on your network. Both SNMP v1/v2 and SNMP v3 are supported. 

• SNMP must be enabled on the switch for Ridgeline to discover the device, and for 
Ridgeline to manage the switch. 

• If you use access profiles to control SNMP, Telnet, and SSH access to your switches, you 
must ensure that the Ridgeline host’s IP address is permitted in those access profiles. 
Ridgeline 4.0 SP2 Release Notes  8
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Ridgeline Device Support

This section contains the following information: 

• New Hardware Devices Supported in Ridgeline 4.0 SP2 on page 9

• All Devices Supported in Ridgeline on page 10

• Extreme Networks Virtualization (XNV) Device Support on page 14

• Other Third-Party Device Support on page 15

• SSH Support on page 16

New Hardware Devices Supported in Ridgeline 4.0 SP2
The following new devices are supported in Ridgeline 4.0 SP2:

• Summit X430-8p, X430-24p

• Summit X440-24tDC, X440-48tDC

• BlackDiamond BDXB-100G4X module (4 × 100Gb Ethernet ports)

• Summit X670-G2 series switches:

X670-G2-48X-4q and X670-G2-72X

• Summit X460-G2 series switches:

X460-G2-24t-10GE4, X460-G2-48t-10GE4, X460-G2-24p-10GE4, 
X460-G2-48p-10GE4, X460-G2-24x-10GE4, X460-G2-48x-10GE4, 
X460-G2-24t-GE4, X460-G2-48t-GE4, X460-G2-24p-GE4, and 
X460-G2-48p-GE4
Ridgeline 4.0 SP2 Release Notes 9
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All Devices Supported in Ridgeline
Ridgeline supports the following Extreme Networks devices:

Table 1: Extreme Networks Devices Supported by Ridgeline

Switches/Modules

ExtremeWare/
ExtremeXOS Versions 
Supported

Summit switches
Summit WM 200/2000, Summit WM 3400/3600/3700, 
Summit WM 100/1000, Summit WM 20

Summit X150 series
Summit X150-24t, Summit X150-48t, Summit X150-24p ExtremeXOS 12.0 SR1 or later

Summit X200
Summit 200-24, Summit 200-24fx, Summit 200-48 7.1e or later

NOTE: S200s stacking not 
supported in 7.1e. Please upgrade to 
7.4 for stacking support.

7.3e or later required for 802.1x and 
SNMPv3 support

7.4 or later required for S200s 
stacking support.

Summit X250 series
Summit X250-24tDC, Summit X250-24xDC, Summit X250-
48tDC

ExtremeXOS 12.0 or later

Summit X250e series
Summit X250e-24t, Summit X250e-24p, Summit X250e-48t, 
Summit X250e-24x, Summit X250e-48p

ExtremeXOS 12.0 or later

ExtremeXOS 12.0 SR1 or later for 
X250e-24x

Summit X300-24
Summit 300-24 7.3e or later

Summit X300-48
Summit X300-48 6.2a or later

7.3e or later required for 802.1x and 
SNMPv3 support
Ridgeline 4.0 SP2 Release Notes  10
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Summit X350 series
Summit X350-24t, Summit X350-48t ExtremeXOS 12.0 or later

Summit X400-24
Summit 400-24t, Summit 400-24p 7.4 or later

Summit X400-48
Summit 400-48 7.2e or later

7.3e or later required for 802.1x and 
SNMPv3 support

7.4 or later required for S400s 
stacking support.

Summit X430
Summit X430-24t, Summit X430-48t

Summit X430-8p, Summit X430-24p

ExtremeXOS 15.3.2 or later

ExtremeXOS 15.5.2 or later

Summit X440
Summit X440-24p, Summit X440-24t

Summit X440-8t, Summit X440-8p, Summit X440-48t, 
Summit X440-48p, Summit X440-24t-10G, Summit X440-
24p-10G, Summit X440-48t-10G, Summit X440-48p-10G

Summit X440-L2-24t, Summit X440-L2-48t

Summit X440-24tDC, Summit X440-48tDC

ExtremeXOS 15.1 or later

ExtremeXOS 15.1.2 or later

ExtremeXOS 15.2.1 or later

ExtremeXOS 15.3.1 or later

Summit X450 series
Summit X450-24t, Summit X450a-24t, Summit X450a-24t-
DC, Summit X450-24x, Summit X450a-48t, Summit X450e-
24p, Summit X450e-48p, Summit X450a-48tDC, Summit 
X450e-24t, Summit X450a-24x, Summit X450a-24x-DC, 
Summit X450e-48t 

ExtremeXOS 11.2 or later

ExtremeXOS 11.5 or later for X450e, 
X450a

Summit X460 series
Summit X460-24t, Summit X460-48t, Summit X460-24p, 
Summit X460-24x, Summit X460-48x, Summit X460-48p

XGM3S-2sf, XGM3S-2xf, XGM3S-4sf modules

Summit X460-G2-24t-10GE4, Summit X460-G2-48t-10GE4, 
Summit X460-G2-24p-10GE4, Summit X460-G2-48p-10GE4, 
Summit X460-G2-24x-10GE4, Summit X460-G2-48x-10GE4, 
Summit X460-G2-24t-GE4, Summit X460-G2-48t-GE4, 
Summit X460-G2-24p-GE4, Summit X460-G2-48p-GE4

ExtremeXOS 12.5.1 or later

ExtremeXOS 15.1 or later

ExtremeXOS 15.6.1 or later

Table 1: Extreme Networks Devices Supported by Ridgeline (Continued)

Switches/Modules

ExtremeWare/
ExtremeXOS Versions 
Supported
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Summit X480 series
Summit X480-24x, Summit X480-24x-SS, Summit X480-24x-
SS128, Summit X480-48t, Summit X480-48t-SS, Summit 
X480-48t-SS128, Summit X480-48x, Summit X480-48x-SS, 
Summit X480-48x-SS128, Summit X480-24x-10G4X, Summit 
X480-48t-10G4X, Summit X480-48x-10G4X, X480-
48t(40G4X), X480-48x(40G4x)

ExtremeXOS 12.4 or later

Summit X650 series
SummitX650-24x, Summit-X650-24t-SS, Summit-X650-24t-
SS512, SummitX650-24t, Summit-X650-24t-SS256, Summit-
X650-24t-SSns, Summit-X650-24x-10G8X, Summit-X650-24x-
40G4X, Summit-X650-24x-SS, Summit-X650-24x-SS512, 
Summit-X650-24x-SSns, Summit-X650-VIM1-256, 
SummitX650-24x-40G4X, SummitX650-24t-40G4X, Summit-
X650-24x-SS256

ExtremeXOS 12.2 or later

Summit X670 series
SummitX670-48x

800400-00 Rev. 05

800400-00 Rev. 06

VIM4-40G4x

Summit X670-48t 

Summit X670-G2-48X-4q, Summit X670-G2-72X

ExtremeXOS 12.6.1 or later

ExtremeXOS 15.1.1 or later

ExtremeXOS 12.6.1 or later

ExtremeXOS 15.2.2 or later

ExtremeXOS 15.6.1 or later

Summit X770 series ExtremeXOS 15.4 or later

BlackDiamond 6800 ExtremeXOS 6.2 or later

0G4Ca module

8500-G24X-e, and MSM24 modules

BlackDiamond 8800 series ExtremeXOS 12.6 or later

BlackDiamond 8900
8900-40G6X-xm, 8900-MSM128, 8900-10G24X-c, and 8900-
G96T-c modules

8900-10G8X-xl, 8900-G48X-xl, 8900-G48T-xl, G24Xe, G48T-
ep, G48T-e, 8500-MSM24, 8500-G48T-e modules

8900-40G6X-xm module

ExtremeXOS 12.3 or later

ExtremeXOS 12.4 or later

ExtremeXOS 12.6 or later

BlackDiamond 10808 ExtremeXOS 11.0 or later

BlackDiamond 12802 ExtremeXOS 12.0 or later

BlackDiamond 12804 ExtremeXOS 11.4 or later

BlackDiamond 20804 ExtremeXOS 12.4 or later

Table 1: Extreme Networks Devices Supported by Ridgeline (Continued)

Switches/Modules

ExtremeWare/
ExtremeXOS Versions 
Supported
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* Ridgeline provides only limited support for the Summit24e2, SummitPx1, Summit WM 100/1000, and Summit WM 200/2000. These 
devices are supported with the same limitations as non-Extreme devices.

If you have a support contract, you can download the latest software versions of 
ExtremeWare or ExtremeXOS from: https://esupport.extremenetworks.com/eservice_enu/
start.swe?SWECmd=Start&SWEHo=esupport.extremenetworks.com.

BlackDiamond 20808 ExtremeXOS 12.4 or late

BlackDiamond X8 Series Switches
BDXA-10G48X I/O module, BDXA-40G12X I/O module, BDXA-
40G24X I/O module (requires a functional BDXA-FM20 fabric 
module), BDX-MM1 management module, BDXA-10G48T

BDXB-100G4X module

ExtremeXOS 15.1 or later

ExtremeXOS 15.5.1 or later

E4G-200 Cell Site Routers ExtremeXOS 15.1.1 or later

E4G-200-12X ExtremeXOS 15.2.2 or later

E4G-400 Cell Site Routers ExtremeXOS 15.1.1 or later

All Summit “i” Series switches
(Summit1i /1iSX, Summit24e3, Summit48i/48Si, Summit5iTX/
LX/SX, Summit7iTX/SX, Summit24e2T/2X*, SummitPx1*)

Alpine
MSM64i

6.2 or later

7.1 or later required for 802.1x and 
SNMPv3 support

Table 1: Extreme Networks Devices Supported by Ridgeline (Continued)

Switches/Modules

ExtremeWare/
ExtremeXOS Versions 
Supported
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Extreme Networks Virtualization (XNV) Device Support
The following devices support Ridgeline’s XNV feature:

Supported VMMs and VMs

Ridgeline supports only the following versions of VMMs:

• VMware 5.0 vCenter Server Virtualization Management 

• Citrix (XenServer) 5.6.0

• Microsoft System Center Virtual Machine Manager (SCVMM) 2.0.4275.0

• Wide Key Support for Policy Rules

When creating some policy rules, you must enable Wide Key on the switch. For more 
information about rules, see the ExtremeXOS documentation.

Table 2: Extreme Networks Devices that Support XNV

Products ExtremeXOS Requirement
Summit X460 series

Summit X460-G2-24t-10GE4, Summit X460-G2-
48t-10GE4, Summit X460-G2-24p-10GE4, 
Summit X460-G2-48p-10GE4, Summit X460-G2-
24x-10GE4, Summit X460-G2-48x-10GE4, 
Summit X460-G2-24t-GE4, Summit X460-G2-
48t-GE4, Summit X460-G2-24p-GE4, Summit 
X460-G2-48p-GE4

ExtremeXOS 12.5.2 or later

ExtremeXOS 15.6.1 or later

Summit X480 series ExtremeXOS 12.5.2 or later

Summit X650 series ExtremeXOS 12.5.2 or later

Summit X670 series

Summit X670-G2-48X-4q, Summit X670-G2-72X

ExtremeXOS 12.6.1. or later

ExtremeXOS 15.6.1 or later

Summit X770 series ExtremeXOS 15.4.1 or later

The following BlackDiamond 8800 c-Series 
modules:

• G48Tc

• G48Xc 

• 10G8Xc

• 10G4Xc

ExtremeXOS 12.5.2 or later

All BlackDiamond 8900 series modules ExtremeXOS 12.5.2 or later

The following BlackDiamond 8800 Pluggable 
options:

• S-G8Xc

• S-10G1Xc

ExtremeXOS 12.5.2 or later

BlackDiamond X8 series ExtremeXOS 15.1.1 or later
Ridgeline 4.0 SP2 Release Notes  14
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Other Third-Party Device Support
Under normal circumstances, Ridgeline provides limited support for non-Extreme devices 
that run MIB-II compatible agents. These devices are supported in Inventory and Alarm 
Manager (for standard SNMP traps).

Ridgeline’s third-party framework enables the integration of additional devices 
independently of Ridgeline software releases. 

Table 3 provides a summary of Ridgeline’s basic support for non-Extreme devices. 

NOTE

Third-party device limitations also apply to the Extreme Summit24e2, SummitPx1, 
Summit WM 100/1000, and Summit WM 200/2000 devices, as well as the Sentriant 
AG and Sentriant NG devices.

Table 3: Third-Party Device Support by Feature

Feature Third-Party Device Support
Inventory MIB-2 compatible devices: status only, SNMP v1 only. Integrated 

support for devices included through the Integration Framework.

Alarms MIB-2 compatible devices: standard traps. Integrated alarm support 
for devices included through the Integration Framework.

Configuration Manager No

Firmware Manager No

IP/MAC Address Finder No

Telnet Telnet supported for selected third-party devices. No SSH support.

Real-Time Statistics No

Map Views Yes, limited to display on map. 

Reports Limited support for MIB-2 compatible devices.
Ridgeline 4.0 SP2 Release Notes 15
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SSH Support
Ridgeline supports the use of SSH for communication with Extreme Networks devices if the 
following conditions are met:

• The SSH Enabling Module must be installed on the Ridgeline server host. Due to export 
restrictions, you must obtain this module from Extreme Networks. It is not included with 
the Ridgeline software distribution. 

• Your switches must be running versions of ExtremeWare or ExtremeXOS that support 
SSH, and SSH must be enabled on those devices. Due to export restrictions, a special 
license is required for the SSH versions of the switch software. To request SSH-enabled 
versions of the software, contact Extreme Networks Technical Support. 

For more information about obtaining and installing these modules, see the Ridgeline 
Installation and Upgrade Guide. SSH is not supported for third-party devices. 

Ridgeline Software Licensing

This section describes:

• The types of licenses available for the Ridgeline software.

• How to determine the number and types of licenses to buy.

License Types
The Ridgeline software supports the licenses described in Table 4.

Table 4: Ridgeline Software Licenses

License Name Features
Ridgeline Base-10a • All product base software features in Ridgeline 

(such as Configuration Manager, Firmware 
Manager, Alarm Manager, Universal Port Manager, 
scripting, topology views, etc.).

• Supports up to 10 devices.

Ridgeline Base-50 • All product base software features in Ridgeline 
(such as Configuration Manager, Firmware 
Manager, Alarm Manager, Universal Port Manager, 
scripting, topology views, etc.).

• Supports up to 50 devices.

• Network users monitoring.

Ridgeline Add 50 Devices • Adds support for an additional 50 devices. This 
license only adds 50 more devices.

Ridgeline Add 250 Devices • Adds support for an additional 250 devices.

Ridgeline Unrestricted • Supports a maximum of 2,000 devices.

Security Feature Pack Base-50 • Adds identity management role-based access 
control.

• Supports up to 50 devices.
Ridgeline 4.0 SP2 Release Notes  16
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Security Feature Pack Add 50 Devices • Adds identity management role-based access 
control for an additional 50 devices.

Security Feature Pack Add 250 Devices • Adds identity management role-based access 
control for an additional 250 devices.

Security Feature Pack Unrestricted • Adds identity management role-based access 
control for a maximum of 2,000 devices.

Data Center Feature Pack Base-50 • Adds support for XNV (ExtremeXOS virtualization).

• Supports up to 50 devices.

Data Center Feature Pack Add 50 Devices • Adds XNV support for an additional 50 devices.

Data Center Feature Pack Add 250 Devices • Adds XNV support for an additional 250 devices.

Data Center Feature Pack Unrestricted • Adds XNV support for a maximum of 2,000 
devices.

Service Advisor Feature Pack • Adds monitoring and provisioning support for E-
Line, E-LAN, VMAN (PB), PBB, and VPLS 
monitoring for up to 2,000 devices.

a. The Ridgeline Base-10 software license is free; it is not upgradeable and technical support is not available. Technical support is 
available for all other software licenses.

License Calculation
Depending on the number of devices you want the Ridgeline software to manage, you might need 
to purchase a combination of licenses or multiples of one license. There are two base licenses, 
which are available for 10 devices (Base-10) or 50 devices (Base-50) devices. The Ridgeline Base-10 
license is not upgradeable. The Ridgeline Base-50 license is upgradeable in increments of 50 and 
250. So, for a network of 245 switches, you would purchase:

1 × Ridgeline Base-50

4 × Ridgeline Add 50 Devices

50 + (4 × 50) = 250

Note that in this example, there are five unused licenses available for future use. We do not offer 
single-switch licenses, and you cannot use the Ridgeline Base-10 license to upgrade in increments 
of 10.

You can obtain a license key at www.extremenetworks.com/support/software

License key installation is separate from the Ridgeline server installation.

After you have determined the type and number of licenses required for your network, and 
obtained a license key(s), you are ready to begin the software installation process. The entire 
process is described in detail in the Ridgeline Installation and Upgrade Guide.

Table 4: Ridgeline Software Licenses (Continued)

License Name Features
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Ridgeline Software Documentation

The Ridgeline software documentation set includes installation instructions, online help, a 
reference guide, and this release note.

Table 5: Ridgeline Software Documentation

Title Content Format  Available at...
Ridgeline Installation 
and Upgrade Guide

How to install the 
Ridgeline software, or 
upgrade from a 
previous version

PDF/HTML • With the Ridgeline software 
installation download file (.zip)

• Extreme Networks 
documentation websitea

Ridgeline Reference 
Guide

How to use the 
features of the 
Ridgeline software

PDF/HTML • Link on the Ridgeline Welcome 
pageb

• With the Ridgeline software 
installation download file (.zip)

• Extreme Networks 
documentation websitea

Ridgeline online help How to use the 
features of the 
Ridgeline software

Web help Available throughout the Ridgeline 
client interface (click Help).

Ridgeline Release 
Notes

Open and known 
software issues, 
resolved problems, 
new features, 
important 
requirements and 
limitations, device 
support, and licensing 
information.

PDF With the Ridgeline software 
installation download file (.zip)

a. The Extreme Networks documentation website is located at www.extremenetworks.com/documentation.
b. Access the Ridgeline Welcome page by entering http://<host>:<port>, where <host> is the name or IP address of the Ridgeline 

server and <port> is the HTTP port number that you assigned to the Ridgeline web server during installation.
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Ridgeline 4.0
Limits
This chapter summarizes the supported and recommended values in Ridgeline Management 
Suite, software version 4.0 Service Pack 2.

Table 6: Recommended and Supported Values

Feature Metric Supported Recommended

Alarm Manager

NOTE: 

• Ridgeline can process 
500 traps/syslog 
messages per minute 
for approximately five 
hours. Exceeding five 
hours may produce 
degraded 
performance.

• If the incoming rate 
per minute exceeds 
500, the remaining 
traps are dropped and 
an incoming SNMP 
traps reached 
maximum alarm is 
generated.

Number of traps/alarms that 
can be processed per minute

500 500

Number of syslog messages 
that can be processed per 
minute

500 500

Number of alarms that can 
be cleared manually

600 
at one time

600 
at one time

Number of alarms that can 
be cleared manually

600 600

Maximum number of active 
alarms

100,000
(older alarms 
that exceed 
100,000 are 
moved to the 
historical alarms 
table)

100,000
(older alarms that 
exceed 100,000 
are moved to the 
historical alarms 
table)

Client Number of clients 5 3

Configuration Manager Number of devices that can 
be included in a schedule

2,000 2,000

Frequency Any Any

Firmware Manager Number of devices that can 
be upgraded at a time

NOTE: Upgrade no more than 
50 devices at a time.

2,000 50
19 SP2 Release Notes



Limits
Groups Number of device groups - 100

Number of devices in a 
group

500 100

Maximum number of devices 
per group hierarchy 
(including devices in parent 
group and its sub-groups)

500 500

Maximum number of groups 
per group lineage (including 
parent group)

5 5

Maximum number of devices 
that can be copied/moved at 
a time

100 100

Maximum number of ports 
that can be copied/moved at 
a time

500 500

Identity Monitoring Number of devices that can 
be selected for Identity 
monitoring at a time

NOTE: Enable ID monitoring 
on no more than 50 devices 
at a time.

100 50

Number of identities per 
minute

- 1,500 identities 
over a period of 5 
minutes 
(Kerberos users). 

NOTE: If there is 
sustained user 
activity (logins/
logouts) for large 
number of users, 
then the client 
performance may 
degrade.

Number of identities - 3,000

Table 6: Recommended and Supported Values (Continued)

Feature Metric Supported Recommended
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Inventory Manager Adding devices 

NOTE: When beyond 1,000 
devices, add no more than 
100 at a time.

150 150

Deleting devices 300 100

Updating devices 200 100

Modifying devices 200 (when 
updating both 
device and 
database)
Unlimited 
(database-only 
change)

100

Detailed polling interval for 
core services
(inventory, topology, VLAN, 
EAPS)
NOTE: You can change the 
default polling settings by 
clicking Communication 
Settings in the Main View or 
group view. It is strongly 
recommended that you not 
reduce the value significantly 
below the default.

Default settings:
5 hours for 
BlackDiamond 
switches
9 hours for 
Summit switches 
(standalone and 
SummitStack)

5 hours for 
BlackDiamond 
switches
9 hours for 
Summit switches

Detailed polling interval for 
non-core services
(XNV, MLAG, VPLS, PBB)
NOTE: The non-core services 
polling settings are not 
configurable.

NOTE: IDM and UPM are by 
default set to only manual 
sync polling. These features 
can be a part of core service 
or non-core service polling. 
You can set this under server 
properties device settings.

Default settings:
Every 25th hour 
for 
BlackDiamond 
switches
Every 27th hour 
for Summit 
switches 
(standalone and 
SummitStack)

Not configurable

Status polling interval 15 mins 15 mins

Logout Number of days exit client Once a day Once a day

Provisioning Number of devices that can 
be selected for VLAN 
creation.

100 100

Reports Number of report clients 5 3

Table 6: Recommended and Supported Values (Continued)

Feature Metric Supported Recommended
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Scripting Number of devices that can 
be selected for a script 
deployment

NOTE: Deploy scripts on no 
more than 100 devices at a 
time.

2,000 100

VLAN Manager Number of network-wide 
VLANs that can be managed

- 15,000

Number of VLANs for a 
device

4,095 4,000

XNV Number of devices that can 
be selected for XNV 
monitoring at a time

NOTE: Enable VM monitoring 
on no more than 25 devices 
at a time.

100 25

Number of virtual machines - 10,000

Table 6: Recommended and Supported Values (Continued)

Feature Metric Supported Recommended
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Ridgeline 4.0
Open Issues, Known Behaviors, 
and Resolved Issues
This chapter describes known problems with the Ridgeline 4.0 SP2 including 
recommendations for workaround when available. It also lists problems that existed in 
previous versions of Ridgeline that have been fixed in this release.

For the latest release notes, patches, and bug list, see: https://
esupport.extremenetworks.com/eservice_enu/
start.swe?SWECmd=Login&SWECM=S&SWEHo=esupport.extremenetworks.com.

This chapter contains the following sections: 

• Issues Resolved in Ridgeline 4.0 Service Pack 2 on page 24

• Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 3 on page 30

• Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 2 on page 31

• Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 2 on page 31

• Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 1 on page 33

• Issues Resolved in Ridgeline 4.0 Service Pack 1 on page 36

• Clarifications and Known Problems in Ridgeline 4.0 Service Pack 2 on page 37

• Troubleshooting on page 41

NOTE

Extreme Networks is transitioning to a new software defect numbering system. 
Previously, software defect ID numbers were prefaced with the letters “PD”; they are 
now prefaced with “rgl.” During this transition period, some software defects will have 
the old format ID and some will have the new one.
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Open Issues, Known Behaviors, and Resolved Issues
Issues Resolved in Ridgeline 4.0 Service Pack 2

Table 7: Issues Resolved in Ridgeline 4.0 Service Pack 2

ID Description

General
rgl0023453 Cannot change the poll interval value in the communications settings for 

devices.

rgl0023470 When adding devices, the password in File > Add Device is used, rather 
than the password set in Tools > Default Communication Settings.

Alarm Manager
rgl0024034 E-mail is not sent for alarms\events after restarting the Ridgeline server.

rgl0024030 Restarting the Ridgeline server causes SNMP/HTTP unreachable alarms.

rgl0023734 The Alarm Manger Outstanding tab takes 4–5 minutes to display +3,000 
outstanding alarms.

rgl0023411 Log messages do not show a source name or IP address variables defined 
for event-based variable. There is no system variable option for source 
device name or IP address.

Client
rgl0023368 There is an inconsistency between which columns are available to be 

hidden in the Table Selector icon versus right-clicking columns.

rgl0023192 Clients can stop responding when they stay connected for more than two 
days or during high levels of activity from the server. 

rgl0022774 Progressing through multiple client views can produce a 
NoSuchEJBException error message.

rgl0022841 When modifying communications settings for a selected device within a 
group, devices not belonging to that group appear.

rgl0019723 Navigating through ribbons/navigation pane can cause Ridgeline to end 
unexpectedly.

rgl0020568 Map operations, such as selecting group nodes/sub-nodes, creating new 
subgroups, renaming groups, etc. occur very slowly.

Configuration Manager
rgl0022695 Configuration backup does not work properly if the frequency is set to 

monthly and if the date is not present in all months (for example: 31, 30, 
29, etc.).

rgl0021910 Creating a baseline configuration fails when Mark As Baseline Later is 
selected.

rgl0023410 Wireless controller with access point detected in inventory by it having an 
IP address is not being added to the configuration global backup 
schedule.

rgl0023731 Can create scheduled configuration backup task with a duplicate name 
that then does not appear in the Configuration Manger Scheduled Tasks 
tab.
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Open Issues, Known Behaviors, and Resolved Issues
rgl0023897 If the Ridgeline server is shut down before scheduled, recurring backups, 
and then restarted, the next scheduled backup time is not correctly 
calculated and shown in the Scheduled Tasks tab.

EAPS
rgl0022823 After adding and deleting a few devices, trying to create EAPS fails and 

the following error message appears:

* EAPS couldnt be created afterwards failing at 
Shared Node Dependancy check or Master Node 
Dependancy Check with exception hit with error "One 
or more parameters not set properly”

Database
rgl0022339 Having a “,," value in a database table column causes data migration to 

fail and display an "unable to convert table data" error. 

Firmware Manager
rgl0024035 Clicking the Update Software information button takes an excessive length 

of time and displays a timeout error. 

rgl0024020 The Apply the selected option for all device(s) check box now implements 
the Download Protocol drop-down box selection (TFTP/SFTP) to all 
selected devices.

rgl0024036 Manually added ExtremeXOS images are not listed in the Distribution And 
Activation dialog box after updating them with the devices to be 
supported. 

rgl0023616 Firmware Manager should use download protocol "SFTP" when SSH is 
configured.

rgl0023552 On the Distribution and Activation dialog box with an SSH XMOD image 
and two devices selected, the Save Settings button does not retain the 
partition settings when switching between the two devices.

rgl0022198 You cannot select the same settings for all the devices on the Distribution 
and Activation (Image Settings tab) dialog box.

rgl0023499 Devices with patch images installed do not show the partition details 
when applying an SSH XMOD upgrade.

Grouping
rgl0021785 Deleting the sub-group with sub-group view open is not removing the 

group name from the left-side tree pane.

rgl0022690 Adding devices to multiple levels of device groups causes the screen to 
refresh repeatedly.

rgl0023569 Group names are not sorted properly on multiple screens.

Identity Manager
rgl0023997 Unable to set the ACL source-address type which prevents using role-

based access control.

Table 7: Issues Resolved in Ridgeline 4.0 Service Pack 2 (Continued)

ID Description
Ridgeline 4.0 SP2 Release Notes 25



Open Issues, Known Behaviors, and Resolved Issues
Inventory
rgl0023735 Modifying Telnet passwords for approximately 2,000 devices fails due to 

timing out.

rgl0021790 Port types and colors are not shown correctly for Summit X670V-48t 
series switches with redundant ports. 

rgl0021308 For chassis/stack devices, in the device panel:

• Information is shown too far down, and the scroll bar moves too 
slowly.

• The separation between the graphical representation and the tabs 
below should be variable.

• Clicking the close/open arrow on the top right-hand corner, which 
hides the device image, creates a blank area. The tabbed area should 
come to the top when the image is hidden.

rgl0020573 Devices discovered with SNMP v3 should be added with v3 credentials by 
default. 

rgl0019200 Should show why discovery of a device fails. 

rgl0022167 The load sharing information that appears is wrong for the ports.

rgl0023739 SNMP-unreachable devices cannot successfully be moved offline using 
communications settings.

rgl0023157 The Summit X440-24tDC switch is not supported.

rgl0023152 After discovering devices within a group, Ridgeline stops responding and 
does not allow new clients to connect.

MAC Finder
rgl0022985 Devices with long ARP or FDB tables cause the IP/MAC Finder to run for a 

long time and then produce no result.

Provisioning
rgl0023991 Error occurs when trying to delete EAPS domain established between two 

devices.

rgl0023976 Deleting VLANs/VMANs from the Main View/group view VLAN tab fails 
and produces an error.

rgl0022507 Ports belonging to the Default VLAN are removed from the Default VLAN 
when you attempt to add those ports to another VLAN. This action should 
produce an error message.

rgl0023055 Ridgeline produces an error and stops responding after adding load 
shared ports to VLANs on Eware devices.

rgl0023841 Removing a port for a selected device from a VLAN, removes that port for 
other devices from the VLAN.

rgl0023931 After the Ridgeline server and clients have been running for longer than 
two days, client stops responding when trying to view a group map.

Table 7: Issues Resolved in Ridgeline 4.0 Service Pack 2 (Continued)

ID Description
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Reports
rgl0021566 MIB Poller Summary report does not work properly. 

rgl0022235 When a device goes to marginal conditions due to an "SNMP status 
marginal" issue, the reason shown in the reports is not correct. 

rgl0023495 Ridgeline’s CA root certificate is expired.

Scripting
rgl0024015 Scripts assigned to a role do not appear for a user with that role when 

logging on using RADIUS authentication.

rgl0021000 Clicking Run Script from a device group causes multiple problems to occur 
with the Run Script wizard. 

rgl0023339 User names with special characters prevent you from viewing script 
results.

rgl0023166 Scripts that do not allow a certain role to run them, can nevertheless be 
run by users assigned to that role.

rgl0022908 When saving a script as a task, the task name field is not consistently 
validated for length and permitted characters in all dialog boxes. 
Character length should be limited to 95, and the special characters, dot, 
hyphen, and underscore should be allowed.

Server
rgl0019395 The following two Telnet properties do not work:

• “Use system login password for telnet/ssh”

• “Device Telnet Width”

rgl0022089 Receiving multiple link down/up traps in a short time period can 
eventually cause clients to stop responding and prevent additional clients 
from connecting to the server.

rgl0022295 Unable to connect a client to the Ridgeline server (Windows 64-bit 2008 
server) after running Ridgeline for a month.

rgl0022368 With 850 devices in inventory, running Ridgeline for two days, causes the 
client to stop responding (also cannot connect with another client) and 
display the following error message:

“2013-08-20 20:44:15,387 ERROR [ClientDataService] 
ClientDataService.printResponseError(line:500): 
Failed to execute | Method : 
EapsDomainDetailsView#updateData - 
EapsClientService#getDomainNodesForEapsDomain | 
Request : GetAttributesRequest

java.lang.OutOfMemoryError: Java heap space...”

Table 7: Issues Resolved in Ridgeline 4.0 Service Pack 2 (Continued)

ID Description
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Topology
rgl0022806 When deleting a VLAN spanning over 540 devices, Ridgeline client stops 

responding during device connectivity check for a few seconds (~30 to 45 
seconds).

rgl0022367 Sometimes all of the nodes in a group are overlapping each other and 
look as if there is only one node in that group.

rgl0020994 The Delete button is not active when you select a user-created link in a 
map. 

rgl0022192 LAG links appear as multiple links in the topology maps. 

rgl0023335 Map views are not saved. 

rgl0023061 In a map, opening the Link Detail window by right-clicking, and then 
clicking Open, does not show the device names for the link.

rgl0022673 After devices are added, map is blank or appears with devices shown as 
boxes (not normal device icons) and links as black lines.

rgl0022719 Selecting a device group causes the following error message to appear:

"Topology memory model construction on server is in 
progress. Group's map will not be shown unless 
server task completes"

After dismissing the error message, you cannot display the map for the 
group.

rgl0023566 Cannot make multiple layout changes to a map.

rgl0022255 Even after deleting all of the devices from inventory, some devices still 
appear in the topology map view.

rgl0023460 Disconnecting a cable from one set of LAG ports, connecting to another 
set of LAG ports on the same device, and then reconnecting back to the 
original LAG ports causes the LAG link to remain in the yellow state on 
the map.

rgl0023477 With EDP only enabled, LAG ports links do not always show the correct 
status color after being disabled, and then enabled.

rgl0023536 Map may show no devices for a group.

Universal Port Manager
rgl0023565 With a large number of groups, you are unable to view all groups in UPM.

rgl0023635 Cannot remove UPM profile associated with a deleted device.

VLANs
rgl0023975 With +1,500 devices, adding devices with multiple VLANs while in the 

VLAN tab can sometimes cause the client to stop responding.

rgl0023961 VLAN tab view for groups does not show all applicable VLANs.

rgl0023815 With +2,000 devices and server running for 4–5 days, editing VLAN 
properties (name, membership, ports, etc.) can fail due to timing out.

rgl0022742 Redundant VLAN/VMANs entries appear.

Table 7: Issues Resolved in Ridgeline 4.0 Service Pack 2 (Continued)

ID Description
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rgl0023009 Using uppercase character for a VMAN name causes the VMAN to appear 
as a VLAN in the VLAN table.

rgl0023015 After a device is copied to a group, only the copied device’s ordinary 
VLANs appear in the VLAN table. VLAN services, such as non iso, iso, 
super, sub, etc., do not appear.

rgl0023581 VLAN overlay does not appear in maps.

Wireless
rgl0023591 Cannot add wireless controller with WiNG 5.5 version.

Table 7: Issues Resolved in Ridgeline 4.0 Service Pack 2 (Continued)

ID Description
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Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 3

Table 8: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 3

ID Description

Alarm Manager
rgl0023401 New alarms do not appear in the Outstanding alarms window when the 

window is undocked.

rgl0023418 Sometimes devices in the map appear with an alarm symbol, though 
there are no alarms for devices. This will happen every 5 minutes. Default 
batch size is 50.

Firmware Manager
rgl0023480 After upgrading ExtremeXOS image, Ridgeline should show the updated 

details about the device.

rgl0023270 Images are not removed from Software Images tab, even after deleting 
the images from Ridgeline's TFTP image-related directories. 

rgl0023271 Current BootROM version running on the devices does not appear in the 
Firmware Manager.

rgl0022916 Ridgeline should detect and list only the devices and partition which have 
the exact base ExtremeXOS version for a SSH XMOD image upgrade.

rgl0023272 Ridgeline does not activate the SSH XMOD image if it is upgraded on a 
non-current partition.

Inventory Management
rgl0023437 The logon credentials set under default communications settings (Tools > 

Default Communications) are not established on devices when they are 
added to inventory.

rgl0023217  Detail polling and syncAtStarup are triggered, but fail to start.

Topology
rgl0023349 With multiple devices, you cannot scroll to view the entire map. The 

viewable area of the map (in range using scroll bars) resets when you log 
on or off.

rgl0023350 With ELSM configured on the network, enabling a disabled link causes the 
switch to send two linkup traps: one with the operation status as down (2) 
and the other as up (1).

rgl0023351 When adding devices to inventory, nodes are added to the map stacked 
on top of each other, so that they appear as only one node.

rgl0023360 Interchanging LAG links produces inconsistent LAG status or removal of 
LAG links.

rgl0023365 LLDP lists itself in its neighbors, so Ridgeline should ignore this self link if 
both end points belong to the same MAC address.

rgl0023430 Failed links appear as yellow, rather than red on the map.

rgl0023476 Moving devices to a group causes single LAG links to appear as multiple 
links.
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Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 2

rgl0023336 Link status changes in the network map display are not promptly 
updated.

rgl0023337 Re-established LAG links are not correctly reported as up.

rgl0023440, 
rgl0023420

Enhancements to SNMP notifications and delivery mechanism, resulting in 
improved network monitoring and topology display. It is intended for 
small-scale, mission-critical networks (100 nodes or fewer) and requires 
ExtremeXOS version 15.3.1.4 Patch 1-41 or later.

Table 8: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 3 (Continued)

ID Description

Table 9: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 2

ID Description

General
PD4-4332298213 Selecting a client port number under Ridgeline Users and Servers > Server 

Properties > Other does not establish the fixed client port.

Alarm Manager
PD4-4441730097 Alarms are not displayed searching with “Received” filter.

PD4-4228140374 Alarms: Few/most of the event-related variables are not properly 
populated for events in message/run command.

PD4-3329347697 Proper operation does not occur when a subgroup is selected and alarm 
propagation is turned off/on for the subgroup from top level menu.

Documentation
PD4-3969594684 Ridgeline Reference Guide topology map information needs to be 

updated to include feature changes in Ridgeline 4.0 SP1 Patch 2:

• Unmanaged devices that have physical links to managed devices in 
inventory will appear with an icon showing MAC address or “unknown” 
text and an “i” symbol.

• In group maps, devices that are not part of the group, but that are 
linked to a managed device in the group, do appear in the map, but 
with an “i” symbol. These manged devices cannot be hidden from the 
group map.

Grouping
PD4-4252886824 Under Main View, deleting a group using the right-click menu deletes the 

group, but the left pane occupies the whole window.

Inventory Management
PD4-3274686804 Unconfiguring and re-configuring a module type on an operational slot 

does not get updated in inventory.
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Provisioning
PD4-3211527303 Provisioning: overall status is not being shown as "Unsuccessful".

RADIUS
PD4-4332099921 After enabling RADIUS client option in Ridgeline, an encrypted password 

is sent to the RADIUS server which produces a “Login failed" message.

If you currently cannot log on to Ridgeline with Ridgeline enabled as a 
RADIUS client, see Unable to Log on to Ridgeline with Ridgeline 
Enabled as RADIUS Client on page 45.

Topology
PD4-4446341136 Zoom out control doesn’t allow you to view the entire map when a large 

number of devices are present (~150).

PD4-4464174931 Red links appear in the topology view, but links are up and show an “UP” 
(green) status under Main View, Link tab.

PD4-3275126711 Removing a link between LLDP-enabled devices is not immediately 
reflected in the map. The map still shows that the link is up.

VLANs
PD4-4458572357 Unable to add ports from devices that are not already existing in the 

specific VLAN.

Table 9: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 2 (Continued)

ID Description
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Table 10: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 1

ID Description

General
PD4-3539442028 Multiple selection capability under Main View, VLAN tab is not needed.

PD4-4138834477 StackOverflowError appears when opening the IP/MAC Address Finder.

PD4-4125580351 For many Ridgeline wizards, selecting one item, and then another causes 
the previous entry’s details to be carried over into the new entry’s details.

PD4-4186524379 JRE issues: Security settings message appears when client is started with 
JRE 1.7.0_40. Warning messages appear when client is started with JRE 
1.7.0_45.

PD4-4332298251 Summit stacking modules do not appear under Device Back Panel when 
stacking is enabled.

PD4-4140812366 Unable to view the configuration files or differences viewer if the custom 
tools are configured.

PD4-4379228667 Ridgeline 4.0 Patch 1: Uninstalling does not remove the new database 
column that was added during the Patch 1 installation.

PD4-4381684013 Summit X770-32q device support needs to be added.

PD4-4408784881 Ridgeline 4.0 Patch 1: Installation in Windows 2012 fails with a "Permission 
Denied" error. This also occurs in Windows 2008 server and Windows 7 
64-bit server.

PD4-4408987111 Installation of Patch 1 build 10 on a Windows 7 64-bit machine fails.

PD4-4408987118 Uninstalling Patch 1 does not remove the new device support files for 
Summit X770.

Alarm Manager
PD4-3579935840 Alarms: The topology does not show the alarms based on the value set 

under Tools > Options > Alarm.

PD4-4220785675 Alarms: The bell symbol does not appear/disappear immediately and 
appropriately for the devices in Main View, Devices tab when alarms are 
raised and cleared continuously.

PD4-4420780844 Alarms: Disabling alarms does not work properly.

PD4-4409107361 Alarm Propagation: The alarm symbol is not updated immediately for the 
devices in the Main View Devices, tab, Groups Devices tab, and the map.

PD4-4406269352 Syslog Alarms: The warning message—indicating that alarms are not 
generated as the Server Properties settings filters syslog messages below 
a certain severity—is not allowing you to define an alarm with lesser 
severity or Syslog-based alarms.

PD4-4382437967 Alarms: Alarms are not listed in Outstanding Alarms view (attached 
database).

PD4-4384840949 Alarm definitions are editable for the raising events and clearing events.

PD4-4379888908 Ridgeline 4.0 Patch 1, Syslog-based alarms: When editing an alarm, 
pattern is made mandatory.
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PD4-4226315471 Alarms Profiles: In Run Script, all bundled scripts (that are internally used 
for provisioning purposes) also appear along with user-created scripts.

PD4-4246628948 Alarms: The number of events count for alarms based on event 
aggregation appears incorrectly for a new client.

PD4-3558231599 Alarms: AlarmSourceDeviceName variable shows an empty value in 
messages/e-mails and also when used in "Run Program".

PD4-3578143314 Alarms: Alarm propagation does not happen properly for both devices 
and subgroups. Alarms are propagated even when the alarm propagation 
is disabled.

PD4-3865363571 Need a way to define alarms based on Syslog messages.

PD4-3770274591 Alarms remain unacknowledged after being cleared.

Configuration Manager
PD4-4357555035 When the Use system login/password for Telnet/SSH property is enabled 

under Ridgeline User and Servers > Server Properties > Devices, the 
Configuration Scheduler does not work.

EAPS
PD4-4347569652 Ridgeline should not show warning message “EAPS Control VLAN not in 

QP8".

Firmware Manager
PD4-4433447781 An empty dialog box appears when the maximum bootROM version is 

null when performing "Distribute and Activate".

PD4-4211466181 Stack slot upgrade always assumes the active partition of the master as 
its slot, but on the device the active partition of the slot is different. 
Therefore, the slot image upgrade fails.

PD4-4181832131 Unable to download images after configuring an HTTP Proxy using 
Ridgeline Users And Servers > Server Properties > External Connections.

PD4-3631042397 Firmware manager does not report incompatibilities between the selected 
upgrade image and the bootROM version running on the device.

PD4-3510032164 XMOD (SSH) image download page does not show the partitions 
(primary, secondary, etc.).

PD4-4377419230 Audit log does not show any details if the Image upgrade result is partial.

PD4-3510032182 XMOD (SSH) image upgrade checks for the same base version or higher. 
It should check only for the exact version match in the base version.

Table 10: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 1 (Continued)

ID Description
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Identity Management
PD4-4411183171 Ridgeline 4.0 Patch 1: Editing ports in ID monitoring flow resets the XML-

notification settings to the default, even when you do not intend to do 
this.

PD4-3607845833 XNV and IDM: The Edit VM Monitoring Port dialog box does not show 
ports that are already enabled for monitoring.

PD4-3280463217 Edit ID monitoring client VR (from VR-default->VR-mgmt and vice versa) 
is not possible.

PD4-3298730579 Edit ID monitoring mode from HTTP to HTTPS and vice versa is not 
possible.

Inventory
PD4-4181832138 Device-Syslog properties appears twice in every Syslog message.

PD4-4350040328 Some stack devices cannot be added to Ridgeline (Failed at "Inventory 
Data Collection").

PD4-3814642037 Serial numbers for stack slots do not appear.

PD4-4110723153 "Additional Info" is not saved when a device is discovered and added.

PD4-3217754449 The "10G2X" card cannot be discovered in Ridgeline.

Provisioning
PD4-4272656041 The Provisioning dialog box needs to be resized to allow selecting devices 

and ports.

RADIUS
PD4-4269949730 The Ridgeline Reference Guide Appendix on RADIUS setup for Ridgeline 

as a client needs to show the latest Windows server versions.

Scripting
PD4-3992615038 Save task option cannot be used after running a script since the Save/OK/

Apply button does not appear in the dialog box. After clicking the Run 
again button, the Save task button is unavailable.

PD4-4321144601 Custom-created scripts are not appearing in the Features drop-down 
menu as per the variable input fields.

PD4-4320325841 Not able to see the macro script results when using a Ridgeline server 
with a dual NIC.

Security
PD4-3187950026 Enabling the Use system login/password for Telnet/SSH property under 

Ridgeline User and Servers > Server Properties > Devices does not work 
properly.

Table 10: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 1 (Continued)

ID Description
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Topology
PD4-4420780428 Topology: The right-click menu in the map does not work, or a null pointer 

exception occurs when clicking Map-Properties.

PD4-4420780372 Topology: The map properties values for the alarms symbol display are 
not taken into effect when invoked in a specific scenario.

PD4-4395323817 Ridgeline 4.0 Patch 1: OutOfMemory exception occurs when setting the 
map (right-click).

PD4-3654217993 Topology (map) background image does not fit correctly into the map 
view. Changes to the map view width/height or removing the image do 
not appear immediately—you must restart the client.

Universal Port Manager
PD4-4268271631 When stack devices are used in Deploy Profiles and Test Profiles wizards, 

the master slot does not appear for the selection of ports (this issue also 
appears in the Test Scripts wizard).

VLANs
PD4-4378717531 Under Main View on the VLANs tab, double-clicking a VLAN (VLAN Details 

window appears), and then clicking on the Links tab incorrectly shows the 
link status as always down.

PD4-3645372949 Editing ports of a VLAN having any uppercase characters happens 
successfully, but the changes do not appear in the Ports tab of the VLAN 
Details window.

Table 10: Issues Resolved in Ridgeline 4.0 Service Pack 1 Patch 1 (Continued)

ID Description

Table 11: Issues Resolved in Ridgeline 4.0 Service Pack 1

ID Description
PD4-3805748941 In the Add Device dialog box, the Manage button isn’t disabled when there 

is no entry in the New Devices to Manage table. Clicking the button with 
no selected devices is a meaningless action.

PD4-4113524281 Switches located beyond the WAN link are not getting added to Ridgeline.

PD4-3708120431 No support for VPLS/MPLS for the BlackDiamond X8 device type.
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Clarifications and Known Problems in Ridgeline 4.0 
Service Pack 2

Table 12: Clarifications and Known Problems in Ridgeline 4.0 SP2

ID Description

General
rgl0023611 Configuration backup fails if a device has more than 1,500 VLANs.

Workaround: Enable HTTP or HTTPS on the device.

rgl0023903 With 2,000 devices and running for approximately four days, changing 
VLAN port names can cause the client to stop responding and display a 
“No EJBReceiver available for node name win2k8r2-
std-sc” error in the log.

Workaround: Start new client.

rgl0023417 In the Task Manager, selecting the Show Task from All Users check box 
does not actually show tasks for all users.

rgl0023798 Changing values in Server Properties can cause unexpected behavior on 
the screen.

Alarm Manager
rgl0023434 Need a Go To Page control in the Outstanding and Cleared Alarms and 

Events tables.

rgl0023827 After receiving continuous Syslog messages for a long time, the receiving 
of Syslog messages may be briefly delayed.

rgl0023828 After exceeding the maximum traps limit, and then not receiving traps for 
approximately five minutes, traps are received, but the "Incoming SNMP 
Traps reached maximum" alarm is not automatically cleared.

rgl0023914,

rgl0023962

Adding devices with alarms to a group that was copied/moved into 
another group does not always propagate the alarm (shown with bell icon) 
up the group hierarchy. 

rgl0023945 Changing the Syslog Server Port property under Devices in Server 
Properties requires a server restart, but you are not alerted to do this.

Workaround: Restart the server after changing the Syslog Server Port 
property.

Configuration Manager
rgl0023242 Ridgeline allows deleting the backup file that you’ve selected for a 

scheduled restore operation. No error message or information appears to 
warn you of this.
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Firmware Manager
rgl0024055 Firmware upgrade for earlier patch images appears to fail with the 

following error:

"Upgrade verification failed as the expected image 
"15.6.1.4" is not active. Please check device log".

Applies to ExtremeXOS patch versions earlier than: 15.2.0.13, 15.1.2.12-
patch1-2, 12.5.4.5-patch1-20, 12.6.2.10-patch1-12.

This is a harmless error, since it fails only on verification and all other 
upgrade procedures are executed properly.

rgl0024045 Upgrading devices with software images that is not digitally signed can 
appear to fail (error message occurs). However, the upgrade has been 
installed.

Workaround: Reboot the device manually after the upgrade is completed.

rgl0023863 Even though a software image exists in the \tftp\ridgeline\images 
location, the Software Images tab does not update to show this with a 
green check mark.

Workaround: Wait for 15–20 minutes for the list to be updated.

Groups
rgl0023759 When managing 2,000 devices with two clients connected for several 

days, multiple group operations can cause the client to become 
unresponsive.

Workaround: Exit the client using java process ID and start new client.

Identity Manager
rgl0023918 With 1,000 users, not all 1,000 are detected and shown in Active and 

Inactive Users tab. Only about +700 users are shown.

rgl0023922 While managing ~1,900 devices and running for three days with client 
opened for two days, enabling IDM for 100 devices displays only 83 
devices under Network-users devices. Disabling IDM for 83 devices times 
out sometimes.

Installation
rgl0023840 Revised server properties are not retained when you upgrade to Ridgeline 

4.0 Service Pack 2.

Workaround: Note your customized settings before upgrading, and apply 
them after moving to Ridgeline 4.0 Service Pack 2.

rgl0023765 On Linux systems, after uninstalling Service Pack 2, server does not start.

Workaround: To resolve this problem, either:

• Before uninstalling, manually backup of the JRE folder, and then replace 
the JRE folder after the uninstall finishes. 

• After uninstalling, download and install Oracle/Sun JRE 1.7.0_40 (this 
version only).

Table 12: Clarifications and Known Problems in Ridgeline 4.0 SP2 (Continued)

ID Description
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rgl0023770 You should not be allowed to uninstall intermediate releases (for example, 
Service Pack 1) with Service Pack 2 installed. This causes the overall 
installation to become unusable.

Workaround: Do not uninstall any intermediate service packs or patches 
after you have installed Service Pack 2.

rgl0023938 Configuration scripts category names are blank after a database migration 
with the installation of Service Pack 2.

Workaround: Assign script category names after the database migration.

rgl0023959 After performing a remote/local database migration while installing 
Service Pack 2 on Ridgeline 3.1 Service Pack 3 in a Windows Vista 
environment, all devices appear in the Main View, but not all devices 
appear in the Configuration Manager.

Inventory
rgl0023847 When discovering devices, in the Device Discovery dialog box, the Timeout 

box appears unavailable (grayed out), but you can edit the value.

MAC Finder
rgl0023981 With 2,000 devices, opening the IP/MAC Address Finder window takes an 

excessive amount of time (~10 minutes).

Provisioning
rgl0023982 With ~2,000 devices, changing the name of a VLAN present on ~85 

devices causes the client to stop responding. 

rgl0023917 The order of steps for creating a protected VMAN should add the 
protected VMAN to the EAPS domain before adding tagged ports to the 
VMAN.

Reports
rgl0023405 In the MIB Query tool, entering a valid table OID returns no values.

rgl0023787,

rgl0023831

Exporting CSV/XML from reports produces results based only on the 
current page of data, and not the entire output of the report.

Server
rgl0023850 There are some server properties that are not useful and some that need 

revised help text.

rgl0023715 Detailed polling with 2,000 devices in inventory causes the Ridgeline 
server to use 95% of CPU.

Scripts
rgl0023243,

rgl0023783

After running a selected script, on the Run Script dialog box Results (last) 
tab, right-clicking the device, and then clicking any of the menu 
commands fails (for example, Telnet Into produces an error message and 
you cannot connect to the device).

rgl0023614 Users without administrator or super-user rights can delete scripts for all 
users.

Table 12: Clarifications and Known Problems in Ridgeline 4.0 SP2 (Continued)

ID Description
Ridgeline 4.0 SP2 Release Notes 39



Open Issues, Known Behaviors, and Resolved Issues
Topology
rgl0023374 Disconnecting a LAG member by disconnecting a cable, and then 

reconnecting to another LAG member should not remove the LAG group 
from the map. LAG status should update appropriately for changes in LAG.

VLANs
rgl0023986 Deleting VLANs causes the VLAN view to become blank for up to a 

minute.

rgl0023869 In map view, links appear with VLAN overlay that are not completely part 
of the VLAN.

rgl0023916 Creating/modifying VLANs on a particular device is not updating the 
VLAN details in Ridgeline. 

rgl0023936 VLANs/VMANs that do not belong to devices in a group appear in the 
VLAN tab for that group.

rgl0023946 Adding all ports (~50/device) from all devices (~100) to a VLAN never 
finishes and causes the client to stop responding.

rgl0023950 Port information does not appear for VLANs in VLAN Properties dialog 
box.

rgl0023967 During VLAN creation, the Available Device and Selected Ports tables do 
not provide keyboard shortcut selection options for convenient selection: 
CTRL + click and SHIFT + click.

rgl0023968 When creating VLANs, Available Devices table is empty after selecting all 
device/ports.

rgl0023987 Deleting devices does not immediately delete associated VLANs. VLANs 
may persist in the Main View/group view VLAN tab for up to an hour.

rgl0023887 The hosts and VMs being managed by the VMM are not imported to 
Ridgeline when the VMM is initially added.

rgl0023964 XNV data is not updated for the device after manual syncing.

Table 12: Clarifications and Known Problems in Ridgeline 4.0 SP2 (Continued)

ID Description
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Troubleshooting

If you are having problems with the Ridgeline server or client, there are several ways you 
can capture information that will be helpful to Extreme Networks Technical Support staff. 

The Package Debug Info Tool
On the Ridgeline server, you can use the Package Debug Info tool to create a zip file of all 
the Ridgeline logs, syslog files, property files and other information, which you can then 
send to your Extreme Networks Technical Support representative for analysis. You can run 
this tool whether or not the Ridgeline server is running. 

For information about using the Package Debug Info tool, see the Ridgeline Reference 
Guide.

Client Information from the About Ridgeline Window
From the Ridgeline client you can display status information from the About Ridgeline 
window: Click Help > About Ridgeline, and then click Details. Status information 
appears in a text window; you can cut-and-paste the information into a file and send it to 
your Extreme Networks Technical Support representative for analysis. 

Collecting Information from Managed Devices
From the Ridgeline Telnet window, you can collect troubleshooting information from the 
devices Ridgeline manages. Once the information is collected and the archive file is created, 
you can send the archive file to the Ridgeline server’s TFTP folder, and then send it to your 
Extreme Networks Technical Support representative for analysis.

To collect troubleshooting information from managed devices:
1 In the navigation pane, click Main View or a device group where the desired device is 

located. 
2 In the devices table, select the desired device by clicking its check box.
3 Click Telnet to Device. A Telnet window appears.
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4 In the Telnet window, enter the show tech all logto file command. The 
following example shows the command and the command messages:

BD-12804.1 # show tech all logto file

show tech command output is logging into internal-memory

...................................................

show tech command output file show_tech.log.gz is saved 
into internal-memory

BD-12804.2 # 
5 Enter the command upload debug <IP_address> where <IP_address> is 

the address of the Ridgeline server. When prompted to run the show tech logto 
file command, enter N. The following example shows the command and command 
messages.

BD-12804.2 # upload debug 10.210.16.74

Do you want to run show tech logto file first? (y/N) No

..........................

The following files on the MASTER have been uploaded:

Tarball Name: BD-12804_AI_09081505.tgz

./show_tech.log.gz

./trace.devmgr.27844

./trace.nodemgr.27845

Tarball Name: BD-12804_AC_09081505.tgz

./epicenter.cfg

./mullai_torino.cfg

./primary.cfg

./secondary.cfg

./snapshot.cfg

./torino-0404.cfg

BD-12804.3 # 
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In this example, two .tgz archives are created: BD-
12804_AI_09081505.tgz and BD-12804_AC_09081505.tgz

6 Verify the location of the TFTP folder by clicking Tools > TFTP server configuration. 
The Configure TFTP Server dialog box (see Figure 1) displays the path to the TFTP 
folder in the TFTP Root box. 

Figure 1: Configure TFTP Server

If the server uses the default system TFTP server, the path is:
\jboss\standalone\deployments\user.war\tftp.

Where <Ridgeline 4.0 install> is:

For Windows: C:\Program Files\Extreme Networks\Ridgeline 
4.0

For Linux: /opt/ExtremeNetworks/Ridgeline 4.0
7 Log on to the server to retrieve the .tgz files using the protocol that the server requires, 

either Telnet or SSH.
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Improper Installing/Un-installing
If problems occur during the un-install process, or if an un-install is performed incorrectly 
(for example, by just deleting all of the Ridgeline files), the installation program might not 
allow you to re-install because it detects the previous installation.

Windows

To solve problems resulting from improper uninstallations on Windows:
1 Remove the following key from Windows registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersi
on\Uninstall\RidgelineX

Where X is the Ridgeline release version that you are trying to un-
install.

2 Remove all Ridgeline entries for the release that you are trying to un-install from the 
following hidden file:

.com.zerog.registry.xml

located at:

C:\Program Files\Zero G Registry\

or 

C:\Program Files(x86)\Zero G Registry\

Linux

To solve problems resulting from improper uninstallations on Linux:
1 Remove Ridgeline entries for the release that you are trying to un-install from the hidden 

registry XML file:

/var/.com.zerog.registry.xml
2 Remove the daemons files:

/etc/init.d/RidgelineServer40

/etc/init.d/RidgelineDB40

/etc/init.d/RidgelineFreeRadius340
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3 Remove the soft links in Linux:

/etc/rc5.d/S74RidgelineDB40

/etc/rc5.d/S75RidgelineServer40

/etc/rc5.d/S76RidgelineFreeRadius40

/etc/rc2.d/K10RidgelineServer40

/etc/rc2.d/K11RidgelineDB40

/etc/rc2.d/K12RidgelineFreeRadius40

Unable to Log on to Ridgeline with Ridgeline Enabled as RADIUS 
Client

You cannot log on to Ridgeline if you configure Ridgeline as a RADIUS client in:

• Ridgeline 3.0 or 3.1, and then migrate to Ridgeline 4.0 or 4.0 Service Pack 1.

• Ridgeline 4.0 or 4.0 Service Pack 1.
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Solution

To resolve this problem:
1 Install the Ridgeline 4.0 Service Pack 1 Patch 2 (see the Ridgeline Install and Upgrade 

Guide).
2 Reset the administrative user password and disable Ridgeline as a RADIUS client 

(Windows only):
a Click Start > All Programs > Extreme Networks > Ridgeline 4.0 > Server 

setup utility. The Ridgeline Server Setup Utility dialog box appears (see Figure 2).
.

Figure 2: Ridgeline Server Setup Utility Dialog Box—Settings Tab

b Click the “admin” password tab (see Figure 3).
.
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Figure 3: Ridgeline Server Setup Utility Dialog Box—”admin” password Tab

c Click Reset “admin” password. 
d Click OK when prompted to confirm resetting the administrative password.

Ridgeline as a RADIUS client is disabled. 
3 Disable Ridgeline as a RADIUS client (Linux only):

a Stop the Ridgeline server service (see the Ridgeline Installation and Upgrade Guide).
b Copy the file update.sql (available in the Linux Ridgeline 4.0 SP1 Patch 2 zip file) 

to the product installation directory.
c Run dbupdate.sh (available in the Linux Ridgeline 4.0 SP1 Patch 2 zip file) with 

the product installation directory as an input argument, where <Product_Install_Dir> 
is the directory in which Ridgeline is installed. By default this is /opt/
ExtremeNetworks/Ridgeline4.0/. For example, ./dbupdate.sh 
opt/ExtremeNetworks/Ridgeline4.0/.

Ridgeline as a RADIUS client is disabled. 
d Restart the Ridgeline server (see the Ridgeline Installation and Upgrade Guide).

4 Log on to Ridgeline:
• In Windows, using the default admin user credentials (name and password = 

“admin”).
• In Linux, using the appropriate local user/admin user credentials.

5 Enable Ridgeline as a RADIUS client (see the Ridgeline Reference Guide).
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